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Setup 
 
Installation 
 

To install the Tony Coleman Drums software and content: 

1. Double-click the .exe (Windows) or .pkg (Mac OS X) installer file you downloaded. 

2. Follow the on-screen instructions to continue the installation. 

Important: Due to the quantity and quality of samples included in the software, allow 
some time for the installation to complete. This could take several minutes. 

3. Authorize your installation of Tony Coleman Drums. See Authorization below to learn how 
to do this. 
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Authorization 
 

To authorize your version of Tony Coleman Drums: 

1. Do one of the following to open the Tony Coleman Drums Authorizer: 
• Double-click the Tony Coleman Drums Authorizer on your computer desktop. 

• Open Tony Coleman Drums on a MIDI track in your digital audio workstation (DAW). 

2. In the window that appears, enter the authorization code 
you received with your installation, and then click Activate. 

Alternatively, click Try to start using a trial version of the 
software, or click Cancel to exit the authorization process. 

 

 

 

3. After clicking Activate, the next window will ask you for your 
authorization code. Enter the code you received with your 
purchase, and then click Next.  

 

 

 

 

4. The next window will ask for your e-mail address.  

If you already have an iLok account, enter your e-mail 
address, check the Register with my existing iLok.com 
account box, and then click Continue. 

If you do not have an iLok account, enter your e-mail 
address, and then click Continue. 



R 

 

6 
 

 

5. If you already have an iLok account, the next window will 
ask for your account information. Enter your iLok User ID 
and Password, and then click Next. Continue on to Step 6 
below. 

 

 

 

If you do not have an iLok account, the next window will 
where you want to store your new iLok license. Click the 
Store button next to On my computer. 

The next window will confirm that your activation was 
successful. Click Continue to finish the authorization. 
You’re now ready to use Tony Coleman Drums—skip the 
following steps, and start making music! 

 

 

6. Select where you want to store your iLok license. Any 
available locations will appear in the panel in the window, 
including your computer or any physical/hardware iLoks 
registered with your iLok account (and are also connected 
to your computer). 

After you have selected your desired location, click Next. 

 

 

7. The next window will confirm that your activation was successful. Click Continue to finish the 
authorization. You’re now ready to use Tony Coleman Drums! 
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Standard vs. 16-Out Version 
 

When you view Tony Coleman Drums plugin after scanning it, you’ll notice there are two 
versions: a standard version and one labeled 16Out. 

 

For the standard version of Tony Coleman Drums, all three of the plugin’s built-in effects will 
be applied to the entire preset. 

 

The 16-Out version of Tony Coleman Drums lets you route each drum or cymbal sound of a 
preset to a specific output (1–8). You can then route each output to a specific mixer channel in 
your digital audio workstation (DAW) for further mixing and processing. This capability allows 
you to set up different effects chains for each output, letting you further customize the sound 
of the kit.  

To learn how to route a sound to an output, see Drum Edit > Outputs (16-Out Version Only). 

To learn how to set the effects for an output, see Effects > Outputs (16-Out Version Only). 

Also, refer to the documentation for your DAW for information on setting up routing for 
multichannel plugins. This is a necessary step for using the 16-Out version; Outputs 2–8 will 
not be heard unless your DAW is configured for this multichannel plugin. 

 

Other than this output routing feature, both versions are identical. 
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Operation 
 
Overview 
 

 

 

The software’s interface is made up of three main areas: (1) the Global Controls, (2) the 
Control Panel, and (3) the Virtual Drum Kit. 

We recommend reading Using Presets to learn about loading and saving sounds in the software. 

See the MIDI Learn chapter to learn how to assign or “map” the software controls to a 
hardware MIDI controller as well as how to save and load them later. 
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Global Controls 
 

 

 

The global controls show the output level and global controls of Tony Coleman Drums, icons 
that allow you to load and save your presets or MIDI Learn files. 

 

The output meters display the real-time level of the stereo 
output. Use these meters to gauge how “hot” your signal is.  

 

Click and drag the Vol knob to adjust the output level. Click 
and drag the Pan knob to adjust the balance of the signal 
between the left and right channels. 

 

The preset selector displays the name of 
the currently loaded preset. Click it and 
use the menu that appears to select and 
load a preset. 

Important: Due to the quantity and quality of samples included in a preset, allow a moment 
for the preset to load. The preset selector will act as a “progress bar” to indicate how much 
time is remaining. 
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The icons let you manage your presets, MIDI Learn files, and software 
settings. 

• Click the folder icon to load a preset (.svx) or MIDI Learn file (.sml). 

• Click the downward arrow icon ([]) to save a preset (.svx) or 
MIDI Learn file (.sml). You can also save your current MIDI Learn 
assignments as the default assignments for the software overall. 

• Click the gear icon to open the Settings window. See Settings to 
learn more about this. 

• Click the Learn button to enter or exit MIDI Learn Mode. See 
MIDI Learn to learn how to assign or “map” the software controls 
to a hardware MIDI controller as well as how to save and load 
them later. 

See Using Presets to learn about loading and saving sounds in the 
software. 
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Control Panel 
 

The Control Panel will display one of three different views: 
Drum Edit, Mixer, or Effects. Switch between the views 
by clicking the corresponding icon. The icon for the 
current view will be lit. 

 
 
Drum Edit 
 

Click the drum kit icon to see the Drum Edit view.  

All of the settings in this view affect only the current drum in the current 
preset. The name of the current drum appears above the Amp/Pitch 
button.  

To select a different drum, click it on the virtual drum kit. 

Important: Some drums or cymbals may have different “articulations.” For example, the snare 
drum has Center, Edge, Rimshot, etc. and the hi-hat has Closed, Open, Stomp-Closed, etc. 
Right-click the drum or cymbal and select the desired articulation. Make sure you click the 
drum or cymbal after selecting the articulation to ensure it is selected. 

 

For each parameter, click and drag its knob up or down to adjust its setting. For the 
envelopes, click and drag its anchor point to the desired position (or click and drag its value 
up or down).  

Tips:  

For each parameter in Drum Edit view, you can alternatively adjust its setting by double-clicking 
the value under it, typing a new value, and then pressing Enter on your computer keyboard. 

For each knob in Drum Edit view, you can set it to its center (“12 o’clock”) position by pressing 
and holding Ctrl (PC) or  (Mac) on your computer keyboard and then clicking the knob. 
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Output (16-Out Version Only) 
The 16-Out version of Tony Coleman Drums lets you assign each drum or cymbal 
sound to a specific output channel (1–8). Each output channel can have its own 
effects chain, letting you further customize the sound of the kit. See Effects > 
Outputs (16-Out Version Only) to learn more. 

 

Amp/Pitch 
While in Drum Edit view, click Amp/Pitch to view the 
amplitude and pitch envelopes of current drum in the 
preset. 

 

These envelopes let you shape and control the volume 
(amplitude) and pitch of a drum sound over a given period 
of time. The upper half of the control panel shows the Amp 
envelope while the lower half shows the Pitch envelope. 

 

Tony Coleman Drums uses AHDSR envelopes. The 
following happens when you trigger a note: 

1. Within the period of time you have defined with the 
attack (Atk) parameter, the volume of that drum’s 
sound rises to its maximum value. 

2. The sound’s maximum volume will be maintained 
during the hold (Hld) phase. 

3. During the decay (Dcy) phase, the sound’s volume will 
gradually drop to the sustain level. 

4. The sound’s volume will stay at the sustain (Sus) level 
until the note stops. 

5. After the note stops, the sound will trail off based on 
the release (Rel) parameter. 
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To adjust each parameter, do any of the following: 

• Click and drag its anchor point to the desired position. 

• Click and drag its value up or down to raise or lower the value.  

 

For the Amp envelope: 

• Click and drag the Volume knob to adjust that 
drum’s maximum volume level. 

• Click and drag the Pan knob to adjust that drum’s 
position in the stereo field.  

 

For the Pitch envelope: 

• Click and drag the Tune knob to set the normal 
pitch of that drum’s sound in semitones. 

• Click and drag the Env Amt (envelope amount) 
knob to set how much the envelope affects the 
sound. At its minimum position, sounds will bypass 
the envelope. At its maximum position, sounds will 
follow the envelope precisely. 
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Equalizer 

While in Drum Edit view, click Equalizer to view the 
equalization of current drum in the preset. This applies 
equalization to the sound, boosting (increasing) or cutting 
(reducing) different frequency bands to shape it. 

• On/Off: Click the on/off button in each column to 
activate/deactivate the equalization for that 
frequency. Each button will be green when on. 

o Lo Shelf: A shelving equalization that will boost 
or cut all frequencies below the cutoff frequency. 

o Parametric 1: A standard equalization that will 
boost or cut the center frequency. 

o Parametric 2: A standard equalization that will 
boost or cut the center frequency. 

o Hi Shelf: A shelving equalization that will boost 
or cut all frequencies above the cutoff frequency. 

• Freq: For Lo Shelf and Hi Shelf, this is the cutoff 
frequency. For Parametric 1 and 2, this is the center 
frequency. This setting is affected by the Q and Gain 
settings. 

• Q: For Lo Shelf and Hi Shelf, this is the slope at which 
the frequency is boosted or cut. For Parametric 1 and 
2, this is the resonance of the frequency (determined 
by the Freq knob) that is affected by the Gain setting. 
Use a higher value to narrow the frequency band or a 
lower value to widen it. 

• Gain: This is how much the frequencies (determined 
by the Freq knob) are boosted or cut. 
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Note Repeat (Note Rpt) 

When Note Repeat is active for a drum, you can continuously re-trigger that 
drum’s sound at a specified rate by holding its note (e.g., pressing and 
holding a pad on a hardware MIDI controller or drawing a long MIDI note 
event in your project). 

To turn Note Repeat on or off, click its on/off button. The button will be red 
when on. 

To set the rate of Note Repeat, click and drag the field up or down. The values are divisions of 
a beat at the current tempo of your project. A T indicates a triplet-based time division. 

 

 

Intelligent Rhythm Control (IRC) 

If you’ve written music with MIDI before, you know how difficult the concept of 
time can be to realizing an effective and artistically rewarding piece of music, 
especially if you’re capturing a performance or creating a track in real time. 

IRC automatically adjusts and corrects your playing to make it “in time” in real 
time, based on your host DAW’s tempo setting. IRC also lets you “humanize” 
your performance by letting some notes play out of time (a little or a lot) based 
on your preference.  

IRC uses the beat resolution you set as a guideline for controlling incoming MIDI notes and 
pushing “early” hits to the next beat. For example, when IRC is set to 1/4, each time you 
trigger a MIDI note, IRC will look at where this note falls in relation to quarter-note intervals. If 
you miss the quarter-note, IRC will push it to the next note interval so that it plays in time. 

To set IRC’s beat resolution, click and drag the IRC field up or down. The lowest position is 
Off. The field will be red when on.  

IRC’s gate lets you set a window of time in which it will not time-correct your notes. For 
example, if you set the gate to 16th Note, you can play up to a 16th note behind IRC’s 
quantization, and IRC will not correct your notes. 

To set IRC’s gate, right-click the IRC field and select the desired setting. 
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Mixer 
 

Click the faders icon to see the Mixer view, which lets you adjust the 
volume levels of the “virtual microphones” of the current preset. 

 

Click and drag each fader up or down to raise or lower the 
volume level of each microphone. Alternatively, click a 
point on the fader line to make the fader “jump” to that 
point. 

 

Kick: The kick/bass drum volume. 

Snare: The snare drum volume. 

Hi-Hat: The volume of the hi-hats. 

Toms: The volume of the toms. 

OH: The volume of the “overhead” microphones, which 
pick up all drums and cymbals. 

Room: The volume of the “room” (ambient) microphones, 
which pick up all drums and cymbals. 

 



R 

 

17 
 

 
Effects 
 

Click the waveform icon to see the Effects view, where you can apply 
compression, equalization, or reverb to the current preset.  

For each parameter, click and drag its knob up or down to adjust its setting. 

Important: For the standard version of Tony Coleman Drums, all three effects will be applied 
to the entire preset. For the 16-Out version, each output (of eight total) will have its own unique 
configuration of the three effects (see below to learn more). 
 

Tips: 

For each parameter in the Effects view, you can alternatively adjust its setting by double-clicking 
the value under it, typing a new value, and then pressing Enter on your computer keyboard. 

For each knob in Drum Edit view, you can set it to its center (“12 o’clock”) position by pressing 
and holding Ctrl (PC) or  (Mac) on your computer keyboard and then clicking the knob. 

 

 

Output (16-Out Version Only) 

The 16-Out version of Tony Coleman Drums lets you route each drum or cymbal 
sound to a specific output (1–8) and then configure the three effects differently to 
each output, letting you further customize the sound of the kit.  

To route a sound to an output, see Drum Edit > Outputs (16-Out Version Only). 

To set the effects for an output, click the Output drop-down menu, and select an 
output (1–8). Any adjustments you make to all three effects will affect the sounds 
routed to that output only. Essentially, each output can have its own unique 
configuration of effects. 
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Compressor 
This applies compression to the preset (or output in the 16-
Out version), reducing the audio signal if it exceeds a certain 
level (the threshold). 

Click the on/off button at the top to activate/deactivate the 
compressor. The button will be green when on. 

This effect has the following controls: 

• Input: This setting lets you raise or lower the gain level 
of the signal going into the compressor. Use this in 
conjunction with the Threshold setting to control when 
compression is applied. 

• Threshold: This is the volume level at which 
compression will be applied. Any sound at this volume 
or higher will be compressed. Use this in conjunction 
with the Input setting. Any signal lower than this setting 
will bypass the compressor. 

• Attack: This is how much time (in milliseconds) the 
compressor takes to start applying compression to the 
incoming signal once it exceeds the threshold. High 
settings may allow some signal peaks to bypass the 
compressor. 

• Release: This is how much time (in milliseconds) the 
compressor takes to stop applying compression to the 
incoming signal once it falls below the threshold. 

• Ratio: This determines how much compression is 
applied to any signal that exceeds the threshold. For 
example, if the Ratio is set to the maximum setting 
(20.00), a threshold increase of level above the 
threshold will result in a 1 dB increase in output (above 
the threshold). The minimum setting (1.00) results in no 
compression. 
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• Knee: This determines how quickly the compressor applies its full amount of 
compression once the signal exceeds the threshold. The minimum setting (1.00%) results 
in a “hard-knee” compression; the fullest amount of compression is applied almost 
immediately. The maximum setting (100%) results in a “soft-knee” compression; gentle 
compression is applied and increases gradually as the signal level increases, producing a 
smoother compression. 

• Output: This settings letls you raise or lower the gain level of the compressed signal. If 
the signal is heavily compressed, you may want to set this to a higher value. 

• Dry/Wet: This control blend the “wet” (affected) signal with the “dry” (unaffected) signal. 
It’s important to strike the right balance between them. 
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Equalizer 
This applies equalization to the preset (or output in the 16-
Out version), boosting (increasing) or cutting (reducing) 
different frequency bands to shape it. 

Click the on/off button at the top to activate/deactivate 
the equalizer. The button will be green when on. 

The equalizer lets you apply the following types of 
equalization: 

• Lo Shelf: A shelving equalization that will boost or cut 
all frequencies below the cutoff frequency. 

• Parametric 1: A standard equalization that will boost 
or cut the center frequency. 

• Parametric 2: A standard equalization that will boost 
or cut the center frequency. 

• Hi Shelf: A shelving equalization that will boost or cut 
all frequencies above the cutoff frequency. 

 

Each type of equalization has the following controls: 

• Freq: For Lo Shelf and Hi Shelf, this is the cutoff 
frequency. For Parametric 1 and 2, this is the center 
frequency. This setting is affected by the Q and Gain 
settings. 

• Q: For Lo Shelf and Hi Shelf, this is the slope at which 
the frequency is boosted or cut. For Parametric 1 and 
2, this is the resonance of the frequency (determined 
by the Freq knob) that is affected by the Gain setting. 
Use a higher value to narrow the frequency band or a 
lower value to widen it. 

• Gain: This is how much the frequencies (determined 
by the Freq knob) are boosted or cut. 
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Reverb 

This applies a reverberation effect to the preset (or 
output in the 16-Out version), emulating the sound 
traveling and reflecting off of surfaces in a virtual room 
or space. 

Click the on/off button at the top to activate/deactivate 
the reverb. The button will be green when on. 

This effect has the following controls.  

• Pre-Delay: This is the amount of time (in 
milliseconds) between the original sound and when 
you hear its first reflection. 

• Width: This is the “spread” of the effect’s signal in 
the stereo field. 

• Size: This is the size of the virtual room—the 
emulated reverberant space. 

• Time: This is the rate at which the reverberation 
decays. 

• Mix: This control blend the “wet” (affected) signal 
with the “dry” (unaffected) signal. It’s important to 
strike the right balance between them, which 
affects how the listener imagines the sound being 
played in a particular room or other space. 

• HF Time: This controls the sound of the high 
frequencies of the reverb’s decay. From -100.00% 
to 0.00%, this acts as a high-frequency dampening 
effect. From 0.00% to 100.00%, this boosts the 
high frequencies. 
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Virtual Drum Kit 
 

 

 

This is the virtual drum kit shows which parts of the preset are being played. You can click on 
a drum or cymbal to trigger it. Alternatively, use a hardware MIDI controller to trigger each 
drum or cymbal (if you have already used MIDI Learn). Each drum or cymbal will light up when 
you play it and when its MIDI note is played on its track in your software. 

Important: Some drums or cymbals may have different “articulations.” For example, the snare 
drum has Center, Edge, Rimshot, etc. and the hi-hat has Closed, Open, Stomp-Closed, etc. 
Right-click the drum or cymbal and select the desired articulation. Make sure you click the 
drum or cymbal after selecting the articulation to ensure it is selected. 
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Using Presets 
 

Presets are the collections of sounds inside the software. Any Tony Coleman Drums file with the 
extension .svx is a preset file. The software includes dozens of presets for you to get started. 

To play a preset, you must load it first. You can also edit any preset and save it as a user preset. 

 

To load a preset:  

1. Click the folder icon.  

2. Choose Load SVX File. 

3. Locate and select the preset file (.svx) you want to play, and click Open. 

Tip: Alternatively, click the preset selector’s down arrow () and use the menu that 
appears to select and load a preset. 
 

Important: Due to the quantity and quality of samples included in a preset, allow a 
moment for the preset to load. The preset selector will act as a “progress bar” to 
indicate how much time is remaining. 

 

To save a preset:  

1. Click the downward arrow icon ([]).  

2. Choose Save SVX File. 

3. Select where you want to save the preset file (.svx), enter a name for the preset, 
and click Save. 
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MIDI Learn 
 

The MIDI Learn feature lets you to assign or “map” Tony Coleman Drums’s controls to any 
hardware MIDI controller. You can create or “learn” a MIDI assignment in Learn Mode. You 
can later remove that assignment (or all assignments), as well. 

 

To create (“learn”) a MIDI assignment:  

1. Click the Learn button (in the window’s upper-right corner) to enter Learn 
Mode, which lets you to assign hardware MIDI controls to the parameters. 
The Learn button will turn blue. 

2. To assign an adjustable parameter, adjust it in Tony Coleman Drums and then move a 
knob or slider on your hardware MIDI controller. That knob or slider will now control that 
parameter. 

To assign a note, click the drum in the Virtual Drum Kit and then press a key or pad on 
your hardware MIDI controller. That key or pad will now trigger that note. 

Important: Some drums or cymbals may have different “articulations,” each of which you 
can assign to a hardware MIDI controller. For example, the snare drum has Center, Edge, 
Rimshot, etc. and the hi-hat has Closed, Open, Stomp-Closed, etc. Right-click the drum 
or cymbal and select the desired articulation. Make sure you click the drum or cymbal after 
selecting the articulation to ensure it is selected. 

3. Click the Learn button again to exit Learn Mode. 

 

To remove a MIDI assignment: 

1. Right-click the software control you wish to reassign or unlearn. (You don’t need to be in 
Learn Mode to do this.) 

2. Select one of the two options: 

• Remove Learn: Clears the hardware control assignment for the selected parameter only. 

• Remove Learn [All]: Clears the hardware control assignments for all parameters. 

You can now assign that knob to another MIDI hardware control. 
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Settings 
 

The Settings window lets you configure certain elements of the software to your 
preference. Click the gear icon in the upper-right corner of the window to open it. 

 

You can configure the following settings: 

• Sample Content Directory: This is the 
file path for your audio samples. Click 
Browse to set a new file path. 

• Browser Database: Click Rebuild to 
rescan your presets. 

• Tooltips: When you hover the mouse 
cursor over a control in the software, you 
may see a tooltip that provides additional 
information about it. Use this menu to turn 
tooltips On or Off. 

• Polyphony: Click and drag this value up or 
down to set the number of voices (notes) 
that can be sounding simultaneously, from 
4 to 128. If Tony Coleman Drums triggers a 
voice beyond this limit, it will sound, but 
another voice (usually the one triggered 
first) will be muted to “make room” for the 
new voice within the polyphonic limit. 

To save your changes and close the Settings 
window, click OK. To close the window 
without saving your changes, click Cancel. 
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MIDI Note Mapping 
 
By Drum/Cymbal Articulation 
 

Drum/Cymbal 
Articulation 

Note 
Number

Note  
Name

Drum/Cymbal 
Articulation 

Note 
Number 

Note  
Name 

Kick 1 36 C1 Hi-Hat Closed 42 F#/Gb1 

Kick 2 35 B0 Hi-Hat Open 46 A#/Bb1 

Snare Center 38 D1 Hi-Hat Stomp-Closed 44 G#/Ab1 

Snare Edge/Brush-Swirl Loop* 40 E1 Hi-Hat Semi-Open 53 F2 

Snare Rimshot/Brush-Swirl* 39 D#/Eb1 Hi-Hat Stomp-Open 55 G2 

Snare Sidestick/Brush Light* 37 C#/Db1 Hi-Hat Bell Closed** 57 A2 

Snare Flam 50 D2 Hi-Hat Bell Open** 59 B2 

Snare Roll** 62 D3 Hi-Hat Dynamic*** 60 C3 

Sticks** 61 C#/Db3 20” Crash 49 C#/Db2 

High Rack Tom 48 C2 18” Crash 51 D#/Eb2 

Mid Rack Tom 47 B1 Fast Crash 52 E2 

Low Rack Tom 45 A1 Ride Center 54 F#/Gb2 

Floor Tom 1 43 G1 Ride Bell 56 G#/Ab2 

Floor Tom 2 41 F1 Ride Bash** 58 A#/Bb2 

 
* Not available for presets with Snare 1 off or Snare 2 off. 

**   Not available for Brush or Hot Rods kits. 

***  Hi-Hat Dynamic responds to both the modulation wheel and CC#4 to dynamically open 
and close the hi-hat. When using electronic drum kits, assign this articulation to your hi-hat 
controller. 
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By MIDI Note 
 

Note 
Number 

Note  
Name 

Drum/Cymbal 
Articulation 

Note 
Number

Note  
Name 

Drum/Cymbal 
Articulation 

35 B0 Kick 2 49 C#/Db2 20” Crash

36 C1 Kick 1 50 D2 Snare Flam

37 C#/Db1 Snare Sidestick/Brush Light* 51 D#/Eb2 18” Crash

38 D1 Snare Center 52 E2 Fast Crash

39 D#/Eb1 Snare Rimshot/Brush-Swirl* 53 F2 Hi-Hat Semi-Open 

40 E1 Snare Edge/Brush-Swirl Loop* 54 F#/Gb2 Ride Center

41 F1 Floor Tom 2 55 G2 Hi-Hat Stomp-Open 

42 F#/Gb1 Hi-Hat Closed 56 G#/Ab2 Ride Bell

43 G1 Floor Tom 1 57 A2 Hi-Hat Bell Closed** 

44 G#/Ab1 Hi-Hat Stomp-Closed 58 A#/Bb2 Ride Bash**

45 A1 Low Rack Tom 59 B2 Hi-Hat Bell Open** 

46 A#/Bb1 Hi-Hat Open 60 C3 Hi-Hat Dynamic*** 

47 B1 Mid Rack Tom 61 C#/Bb3 Sticks**

48 C2 High Rack Tom 62 D3 Snare Roll**

 
* Not available for presets with Snare 1 off or Snare 2 off. 

**   Not available for Brush or Hot Rods kits. 

***  Hi-Hat Dynamic responds to both the modulation wheel and CC#4 to dynamically open 
and close the hi-hat. When using electronic drum kits, assign this articulation to your hi-hat 
controller. 
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System Requirements and Product Support 
 

For complete system requirements, compatibility information, and product registration, visit 
the SONiVOX website: sonivoxmi.com. 

For additional support, visit sonivoxmi.com/support. 

 
 

Trademarks and Licenses 
 

SONiVOX is a trademark of SONiVOX LP, registered in the U.S. and other countries. 

inMusic is the exclusive distributor of SONiVOX. 

iLok is a trademark of PACE Anti-Piracy, Inc. 

Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. 

Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. 

All other product names, company names, trademarks, or trade names are those of their 
respective owners. 
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